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3 SP-PAM 

Application and Structure  
 

The SP-PAM system is designed for analysis of stress periods in tree growth. It consists of two 
parts:  

1. Desktop Application. 
2. Web Application. 

Chapter Two describes the functions of the desktop application and Chapter Three of the web 
application.1.  
 

1. Main Definitions 

 

  1.1 Stress periods 

 

Tree rings are a reliable sistem for storing information about the event and the influence of 
environmental factors on growth. 

The samples for the dendrohronological analysis were taken from dominant tree species in 
forest communities. Sampling is performed with Preslerov drill at 1 - 1,5 m. and the width of each 
ring is measured. The measurement result is obtained from the ordered sequence (year, latitude) 
probed for each individual as shown in Figure 1. 

 

 

Figure 1 Change in the annual tree ring widths 

The obtained data is used as an input for the regression analysis. The purpose of the 
regression analysis is to find a polynomial that approximates the best data from a 
dendrohronological row. Criterion of proximity of the approximative polynomials to the initial 
data is given by the determination coefficient h R2 ( 0 ≤  R2   ≤  1). Bigger values of R2 mean bigger 
approximation. 
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After calculating the approximated values the index values are calculated as a relationship to 
the approximated value of width for each year. Figure 3 shows a graph of the calculated indices 
compared to the measured ones shown on Figure 2. When the index value is outside of the 
acceptable range for normal values say that the year in which it is observed, is a stressful year for 
the growth. The sequence of one or more adjacent stress years is perceived as stress period. Each 
stress period is set by a couple years - the initial year (LB) and the end year (RB) sequence. When 
the stress period consists of one year the right and left border is the same. 

 

 

Figure 2 Measured and approximated annual tree ring widths 

 

 

 

Figure 3 Indexes calculated through regression analysis 
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 1.2 Stress years and Stress periods 

 

Measurement of the stress periods of an individual sample of a species is not sufficient to 
conclude on the type of stress. Obviously it is necessary to find a common stress periods for a greater 
number of speciments  of the same species.  

Let А indicate the stress periods for one dendrohronological row: 
(1) A = { SIi , i = 1 ……n, },  
where SIi  are the specific stress years. The stress years could be arranges in an increasing order i.e. in 
the multitude of A there is a specific order. S indicates the multitude of all multitudes of stress years 
for the sampled tree specimens from the same species: 
 (2)       S = {Ai  i   {1 … n} }, where Ai  are the multitudes of stress years of separate 
dendrohronological rows; 
 represents a multitude of  sections of stress years. 

(3)        = {I | I = {
1

1

j

iSI ,
2

2

j

iSI ,…, 
jk

ikSI  } : 
1

1

j

iSI ∩ 
2

2

j

iSI ∩… ∩
jk

ikSI     Ø  where 
1

1

j

iSI    
1

1

j

iA , … 
jk

ikSI    
jk

ikA   

^ 
jk

ikA    S  ^      
jm

imSI    Aim   where   im  { i1, ... ik }  such that   
jm

imSI ∩
1

1

j

iSI ∩ 
2

2

j

iSI ∩… ∩
jk

ikSI     Ø  }.  

This means that each element consists of multitudes of separate stress years from 
dendrohronological rows Ai   S, which contain stress years with total non-empty section. For brevity 
sections of stress years will be called stress years. Sections that have consecutive years we would call 
stress periods.  Stress periods characterize with the following parameters - cardinality (CARD), 
left border year (IL), right border year (IR), coverage (CO), confidence interval, standard deviation и 

alpha    . With cardinality we denote the number of the separate stress periods that belong to 

stress section I    . The coverage (CO, %) is the relation between the cardinality and the number 
(N) of all dendrohronological rows Ai such as :    

EYi   IL    IR   LYi , where EYi и  LYi  are the earliest and the latest years from Ai.  
 
 (3)      CO = 100*CARD/ N 
 
 With   (IM) we denote the middle of each stress period. 
(4)   IM = (LB + RB +1)/2 . 

The average values of the midpoints are denoted with М and   



s

i

iIM
s

M
1

1
 , 

where IMi  are the midpoints of the separate stress periods, constructing the stress section. The 
standard deviation   (STD) is the standard deviation of the midpoints IMi  of the separate stress 
periods. 
(MINT) is the middle of the shared interval.. 
AMPL  is the amplitude (depth) of the stress.  

(5)  



s

i

iIND
s

AMPL
1

)1(
1

  where INDi   are the middle indexes of the stress years of the shared 

period and belong to the respective dendrohronological rows. 
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 2. Description of the desktop application 

  2.1 Application purpose 

The main purposes of the application are: 
1. Locating sections of stress periods for each type of wood, for which data exists, and the 

characteristics that are described above. 
2. Providing statistical information for the studied tree species. 
3. Regression analysis of the calculated indices relative to the climatic data. 

 

  2.2 Language for input data description 

Application input data.  
 Each line begins with a description of the keyword. Each keyword is followed by zero or more 
parameters. The description of the keywords and their importance and the related parameter 
follow. 

SPECIMEN = {name and species} / {ROW| INDX} – specifies the name of the specific instance 
of which the dendrohronological row is measured / means that an option is set for the data type. 
ROW is a data option from the type year and tree ring width. INDX denotes indexes, and not tree 
ring widths. Mandatory keyword. 

NROWS = {number of rows} – denote the number of rows that set the measured 
dendrohronological row. 
 RAW = {year} {tree ring width} – denotes a paired data sets describing the dendrohronological 
row. The width of annual rings is a real number. 
 INDX = {year, index} - denotes a paired data sets describing the indexes of the 
dendrohronological row. 

 An Example of input data is shown below: 
 

Table 1 Example description of dendrohronological rows of Fagus sylvatica L. 
 

SPECIMEN = Chuprene  2 /RAW 

 NROWS = 34 

RAW =  1968 1,19 

RAW =  1969 0,935 

RAW =  1970 0,73 

RAW =  1971 0,685 

RAW =  1972 0,715 

RAW =  1973 0,57 

RAW =  1974 0,52 

RAW =  1975 0,535 

RAW =  1976 0,505 

RAW =  1977 0,575 

RAW =  1978 0,885 

RAW =  1979 0,88 

RAW =  1980 0,835 

RAW =  1981 0,735 

RAW =  1982 0,865 

RAW =  1983 0,89 
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2.3 Results Description. 

 

The processing of input data is performed in two stages. The first one is pre-processing or 
compilation and the second is finding the stress sections. In both stages the results from the 
processing of input or intermediate data are displayed.  
While compiling the following operations on the input data are performed: 

1. Read the data and check for errors. For ease of use of the application and reducing error 
messages all lines starting with undefined keywords are ignored. 

2 . Find the equations of polynomials approximating each dendrochronology . Selection of the 
polynomial approximating the best data by each of them. Dendrochronology for which R2 is less than 
0.45 are rejected as unreliable. Calculating the indices of the dendrohronological rows which are 
considered as reliable. 

3 . Calculating all the best formulas and the corresponding values of R2 by type , area of 
sampling , individual. Calculating the average of the indices of reliable dendrohronological ranks. 
Calculating the correlation coefficients between the indices of reliable dendrohronological ranks. 

4 . Calculating the autocorrelation matrix of the width of annual growth rings for the location. 
5 . Calculation of the correlation matrix between the indices of the rows of the location. 
6 . Analysis of these climate data and calculated indices in the manner in which they are 

calculated for the width of the annual rings. 
7 . Determine the type of each climate year . 

 
 Table 2 shows an example result of an analysis. 
 

Table 2 Analysis result 

   
 

Species Fagus sylvatica   

Specimen 

Type of 

Approximation Formula R^2 

Western Balkan 1   

1 Linear -0.00090872x+1.9134 0.14923 

2 

Polynomial of 

2th degree -4.9846e-05x^2+0.19299x^1-186.61 0.47914 

3 

Polynomial of 

3th degree -5.959e-07x^3+0.0034272x^2-6.5689x^1+4196.1 0.51253 

4 

Polynomial of 

4th degree +4.6505e-08x^4-0.0003624x^3+1.0589x^2-1374.9x^1+6.6932e+05 0.65468 

5 

Polynomial of 

5th degree 

-6.7204e-10x^5+6.5821e-06x^4-0.025784x^3+50.495x^2-

49440x^1+1.9361e+07 0.67529 

6 

Polynomial of 

6th degree 

+1.0217e-11x^6-1.199e-07x^5+0.0005863x^4-1.529x^3+2242.9x^2-

1.7547e+06x^1+5.7195e+08 0.67859 

7 

Polynomial of 

7th degree 

+5.8862e-13x^7-8.0038e-09x^6+4.6639e-05x^5-

0.15097x^4+293.21x^3-3.4164e+05x^2+2.2113e+08x^1-6.1338e+10 0.68547 

8 

Polynomial of 

8th degree 

-4.5315e-15x^8+7.1099e-11x^7-4.8798e-07x^6+0.0019136x^5-

4.6893x^4+7353.4x^3-7.206e+06x^2+4.0347e+09x^1-9.8819e+11 0.68572 
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Year Measured data Approximation Index 

1893 0.24 0.23193 1.0348 

1894 0.23 0.22205 1.0358 

1895 0.2 0.20569 0.97234 

1896 0.145 0.19299 0.75132 

1897 0.16 0.17737 0.90208 

1898 0.155 0.16248 0.95399 

1899 0.145 0.15344 0.94498 

1900 0.13 0.14282 0.91022 

1901 0.13 0.1322 0.98334 

1902 0.135 0.12317 1.0961 

    

  

  

 Table 3 shows the calculated statistics by species, sampling region and individual. The first 
column is the name of the sampling region. The second – the names of the respective individuals. In 
the third – the equations of the best approximating polynomials for all dendrohronological rows. The 
forth column contains R2.  
 

 
Table 3 Statistics generated during input data compilation stage. 

 

Location Specimen Best approximation polynomial 

 

Best 

approximation 

R^2 Year 

Average 

index 

Number 

of 

samples 

Western Balkan      

 

Western 

Balkan 1 

-4.5315e-15x^8+7.1099e-11x^7-4.8798e-

07x^6+0.0019136x^5-4.6893x^4+7353.4x^3-

7.206e+06x^2+4.0347e+09x^1-9.8819e+11 0.68572 1893 1.0348 1 

 

Western 

Balkan 2 

+1.157e-13x^7-1.5473e-09x^6+8.8628e-06x^5-

0.028185x^4+53.744x^3-61444x^2+3.8998e+07x^1-

1.06e+10 0.38323 1894 1.0358 1 

 

Western 

Balkan 3 

+2.8837e-09x^6-3.4209e-05x^5+0.16909x^4-

445.74x^3+6.6095e+05x^2-

5.2269e+08x^1+1.7223e+11 0.63614 1895 0.97234 1 

 

Western 

Balkan 4 

+6.3521e-09x^6-7.5331e-05x^5+0.37223x^4-

980.95x^3+1.4541e+06x^2-

1.1496e+09x^1+3.7869e+11 0.65495 1896 0.75132 1 

 

Western 

Balkan 5 

-6.8493e-12x^7+9.3757e-08x^6-

0.00055x^5+1.7924x^4-3504.6x^3+4.1113e+06x^2-

2.6794e+09x^1+7.4831e+11 0.2675 1897 0.90208 1 

 

Western 

Balkan 6 

+2.1851e-10x^6-2.5732e-06x^5+0.012625x^4-

33.037x^3+48627x^2-3.8172e+07x^1+1.2485e+10 0.53053 1898 0.95399 1 

 

Western 

Balkan 7 

-2.4027e-12x^7+3.2805e-08x^6-

0.00019194x^5+0.62389x^4-

1216.6x^3+1.4234e+06x^2-

9.2515e+08x^1+2.5768e+11 0.50751 1899 0.94498 1 

 

Western 

Balkan 8 

-3.0122e-13x^7+4.108e-09x^6-2.4008e-

05x^5+0.077943x^4-151.81x^3+1.774e+05x^2-

1.1516e+08x^1+3.2035e+10 0.45368 1900 0.84806 3 

 Western -1.251e-12x^7+1.7125e-08x^6- 0.37904 1901 1.0409 4 
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Balkan 9 0.00010046x^5+0.32737x^4-

640.06x^3+7.5082e+05x^2-

4.8927e+08x^1+1.3664e+11 

 

Western 

Balkan 10 

-6.9723e-12x^7+9.5438e-08x^6-

0.00055986x^5+1.8245x^4-

3567.3x^3+4.1847e+06x^2-

2.7271e+09x^1+7.6164e+11 0.26156 1902 1.0219 4 

 

Western 

Balkan 11 

+2.6176e-10x^6-3.1084e-06x^5+0.01538x^4-

40.581x^3+60227x^2-4.767e+07x^1+1.572e+10 0.47527 1903 1.0798 4 

 

Western 

Balkan 12 

-1.215e-11x^7+1.6753e-07x^6-

0.00099002x^5+3.2501x^4-

6401.5x^3+7.565e+06x^2-

4.9664e+09x^1+1.3973e+12 0.31843 1904 1.0259 4 

       

 

 

 Table 4 shows the matrix of correlation coefficients between the indexes of the reliable 
dendrohronological rows.  
 

 
Table 4 Correlation coefficients of dendrohronological rows indexes. 

 

 For each sampling region (location)  additional average characteristics are shown: 
 

 Location name. 

 Sampled species names. 

 Equation of the best approximating polynomial for each individual. 

 Relative value of R2. 

 Average indexes, resulting from the reliable dendrohronological rows, specified for the 
species – year, average index, row number, for which the average index is calculated. 

 
 Table 5 shows a sample location characteristic. 
 

Correlation coefficients

Western Balkan 1Western Balkan 3 Western Balkan 4 Western Balkan 6

Western Balkan 1 0.52 0.26 0.04

Western Balkan 3 0.15 0.11

Western Balkan 4 0.16
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Table 5 Location characteristics. 

 

Locatio

n 

 

Specimen 

 

Best approximation polynomial 

 

Best 

approximatio

n 

 R^2 

Yea

r 

 

Averag

e  

index 

 

Numbe

r  

of 

sample

s 

Petroha

n        

 

Petrohan_

1 

+8.9744e-05x^5-0.86219x^4+3313.3x^3-

6.3663e+06x^2+6.1163e+09x^1-2.3504e+12 0.19298 

191

7 

0.9932

8 2 

 

Petrohan_

2 

-5.0641e-05x^5+0.48668x^4-

1870.9x^3+3.5959e+06x^2-

3.4558e+09x^1+1.3285e+12 0.80171 

191

8 

0.9528

6 2 

 

Perohan_

3 

-0.00078462x^5+7.539x^4-

28975x^3+5.5681e+07x^2-

5.3501e+10x^1+2.0563e+13 0.82908 

191

9 

0.9530

6 2 

    

192

0 1.0897 2 

    

192

1 

0.7350

7 2 

    

192

2 1.0833 2 

    

192

3 1.1631 2 

    

192

4 0.8454 2 

    

192

5 1.0482 2 

    

192

6 

0.8945

5 2 

       

 

 Also the following characteristics are displayed: 
 

 The equations of approximative polynomials in temperature and precipitation. 

 Suitable values of R2. 

 For each year for which data are available for widths of annual rings, temperature and 
precipitation , the following information appears - year average index of the width of annual 
rings dendrohronologichnite forefront of location , temperature index, rainfall and type of the 
year. Type of year for short is specified as - the first letter may be N - normal year , W - warm 
year or C - cold year and the second N - normal year , W - wet year or D - dry year . These 
labels depend on the value of the corresponding index. 
 

Table 6 Location characteristics connected to climate data. 
 

Climate Width Temperature Precipitation Type of year 

Polynomial 

-3.4253e-11x^7+4.703e-07x^6-

0.0027673x^5+9.0459x^4-

17741x^3+2.0876e+07x^2-

1.3646e+10x^1+3.8228e+12 

+2.9087e-10x^7-3.9574e-06x^6+ 

0.023072x^5-74.722x^4+1.4518e+ 

05x^3-1.6924e+08x^2+1.0958e+ 

11x^1-3.0408e+13 
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R^2  0.054965 0.15249  

Year 

Width  

index Temperature index Precipitation index 

1917 0.99328 1.0159 0.92622 NN 

1918 0.95286 0.97602 1.0731 NN 

1919 0.95306 1.011 1.2981 NW 

1920 1.0897 0.9785 0.66689 ND 

1921 0.73507 0.97166 1.053 NN 

1922 1.0833 0.99343 0.86377 NN 

1923 1.1631 1.0499 1.2729 NW 

1924 0.8454 0.97775 0.99302 NN 

1925 1.0482 1.0152 0.90687 NN 

1926 0.89455 1.0443 0.84161 NN 

 

 After approximation and filtering of the input data the second stage of processing begins. 
During this stage the following operations on the intermediate reliable dendrohronological data are 
performed:  

1. Locating the stress section and calculation of the statistical characteristics. 
2. Calculating the statistical characteristics of dendrohronological rows separately by area of 

sampling and the species as a whole. 
 

 Stress sections and statistical data 
 

 Table 7 a and b shows a sample excerpt of a part of a description of a stress section. Columns 
(а) show the species name, number, name of the dendrohronological rows,   first and last years of 
the dendrohronological rows, the stress period which is part of the section,  amplitude of the shared 
stress period, cardinality,  coverage, middle of the total period, standard deviation, confidence 

interval,   , intersection and union of the stress periods. 
 

Table 7 a Stress sections and statistical data. 

 

Pinus nigra No Specimen 

Earliest 

Year Latest Year Interval  Amplitude Cardinality 

 1 Vitosha 1 1901 2000 1968 1972 0.204798 22 

  Vitosha 2 1906 2000 1968 1974 0.181296  

  Vitosha 4 1903 2000 1968 1973 0.104699  

  Vitosha 6 1895 2000 1968 1969 0.277354  

  Vitosha 7 1909 2000 1968 1970 0.021656  

  Vitosha 8 1914 2000 1966 1976 0.1808  

  Vitosha 10 1912 2000 1966 1970 0.280289  

  Vitosha 11 1949 2000 1965 1969 0.066499  

 
Table 7 b Stress sections and statistical data (continued) 

 
Coverage 

% Mean 

Standard 

deviation Confidence Alpha Intersection Union  

81.48 1968 1.708 16 0.25 1968 1968 1962 1978 
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 The statistics related to the stress periods of the dendrohronological sequences are shown in 
Tables 8a and b. These include the period of each dendrohronological row, the number of stress 
periods, frequency of stress periods, calculated for 100 years, the average amplitude, the largest 
amplitude, the average length of the stress period, the longest stress period - initial and final year. 
The same data - aggregated and averaged are calculated and for the specific species sampling 
location. 
 

Table 8 a Statistics connected to the stress periods of dendrohronological rows. 

 

Fagus sylvatica     

 Period  

Number of stress 

periods Frequency 

Petrohan     

Petrohan_2 1900 1909 5 50 

Perohan_3 1900 1909 3 30 

Average per Location 1900 1909 4 40 

     

Boishte     

Boishte_1 1913 1922 3 30 

Average per Location 1913 1922 3 30 

     

Gabra     

Gabra_1 1900 1909 5 50 

Gabra_2 1900 1909 3 30 

Average per Location 1900 1909 4 40 

     

Average per Species 1900 1922 3.667 36.67 

 

 
Table 8 b Statistics connected to the stress periods of dendrohronological row (continued). 

 

       

Average 

amplidude 

Highest 

amplitude 

Average 

period 

Longest stress 

period 

Longest stress period 

length 

       

0.1094 1907 0.1904 1.2 1906 1907 2 

0.2245 1907 0.4585 2.667 1900 1902 3 

0.1669 1907 0.4585 1.933 1900 1902 3 

       

       

0.05989 1915 0.103 2 1918 1920 3 

0.05989 1915 0.103 2 1918 1920 3 

       

       

0.1094 1907 0.1904 1.2 1906 1907 2 

0.2245 1907 0.4585 2.667 1900 1902 3 

0.1669 1907 0.4585 1.933 1900 1902 3 

       

0.1313 1907 0.4585 1.956 1900 1902 3 
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  2.4 Desktop application functions description 
 

 Figure 4 shows a general view of the application. The desktop application is a table containing 
the results from the processing of the input data. 
 

 

Figure 4 Overall application view. 

 

 With marking the cells or part or them the marked area could be copied Ctrl C  on the 
clipboard and subsequently transferred into Excel, Open Office Calc or another application. 
 

2.4.1 File manipulation functions 

 

The file functions menu is shown in Figure 5.  New input description opens with the sequence: 
File -> New description  - a file choice dialog appears, as shown on Figure 6. 
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Figure 5 File manipulation menu. 

 

 

If the function New Description is selected a dialog for file choice appears, containing a description of 
rows of tree ring widths from a location, as shown on Figure 6.  
 

 

Figure 6 File choice with input description dialog. 
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 Users can choose two types of input description formats – description, which is standa5rd for 
the application(.txt extention) and a description which is specific to some dendrohronological 
databases (.rwl extention). Table 9 shows an example of an .rwl description of the tree rings. The .rwl 
format is the de facto standard for the description of the measurements of widths of annual rings. 
 

Table 9 Example data format from .rwl file. 

 
 

626    1 Blumone, Malga WIDTH_RING PCAB - 

626    2 Italy   Norway spruce 1650  4553-1025 1840 1980 - 

626    3 FRITZ SCHWEINGRUBER - 

626031  1851   262   241   176   188   300   295   230   262   290 

626031  1860   251   321   263   350   305   404   369   379   340   265 

626031  1870    53    47    97   132   132   118   151   118   138   145 

626031  1880   143   116   113   104    98   137   138   124   155   130 

626031  1890   120   117   137   177   175   189   177   167   159   168 

626031  1900   152   194   213   208   307   242   215   185   187   166 

626031  1910   112   184   205   158   103   150   181   225   206   165 

626031  1920   217   185   157   129   175   159   158   184   184   218 

626031  1930   198   166   135   123   154   138   114   133   106   133 

626031  1940   133   132   253   211   238   300   263   313   273   313 

626031  1950   252   179   273   309   246   275   262   253   190   262 

626031  1960   278   243   210   223   323   292   258   273   288   293 

626031  1970   260   283   239   250   233   229   218   198   208   241 

626031  1980   187   999 

 

 

After selecting the file with a description of the widths of the annual rings, the user must enter the 
place of sampling:, 

1. From the list of countries a country is chosen. 
2. In the Location name a name of the location must be entered. 
3. In the fields Location latitude, Location longitude and Location altitude appropriately are 

fed geographical width geographical longitude and altitude of the location. The data is an integer 
format as in the standard .rwl files. The system converts them to decimal numbers. The last two 
digits are converted into tenths and hundredths of a geographical degree. 
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Figure 7Sample location data choice. 

 

 After selecting the OK button a dialog for selecting the sampled tree species is shown, as 
shown in Figure 8. 
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Figure 8 Tree species choice dialog. 

 

The functions Open, Save and Save as in the current version work with files containing comma 
separated fields(csv). The buttons for the functions New description, Open and Save from the File 
menu are shown on Figure 9. 
 

 

Figure 9 New description, Open and Save functions buttons. 

2.4.2 Cell editing functions 

 
The functions for cell redactions are located in the Edit menu. Figure 10 shows all cell 
redaction functions. 

 

Figure 10 Cell editing functions. 
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2.4.3 Tools 
 

When choosing Tools-> Settings the dialog shown on Figure 11 appears. Here it can be 
choosen which of the following data to appear when showing the data for stress sections. 

 

 

Figure 11 Tools 

 

 The options that can be set in the window shown below are: 
 

 Minimal coverage – the minimum amount of coverage rates over which stress sections are 
considered reliable. 

 Variation interval – The value of the percentage for which it is assumed that the indexes 
are not stressful. If this value is not set the confidence interval of the sequence of indices 
is chosen. 

 The following options determine whether to display certain characteristics of stress sections 
of all intervals or only those for which climate information is available.  
The last group of options specifies which of the calculated data are to be virtualized.  
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Figure 12 Stress sections characteristics condition choice. 

 

2.4.5 Functions for displaying statistical information 
 

Statistical information related to the results of data processing of the measured widths of 
annual rings and stored air information can be obtained by selecting the menu item - Statistics-> 
By Geolocation as shown in Figure 13. Then a wood species is selected, as shown in Figure 8. 
After the selection of tree species a parameters of statistics are introduced: 

1. Geographic coordinates - longitude, latitude and altitude. 
2. Select information output - on screen or csv file. 
3. Choice of statistics data. 
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Figure 13 Geographic coordinates statistics function choice. 

 

 

Figure 14 Geographic coordinates statistics parameters choice. 
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2.4.5 Functions for regression analysis 
 

The application supports functions for regression analysis. Regression analysis includes functions for 
multidimensional linear analysis and one-dimensional nonlinear analysis. In both cases, the 
dependent variable is a variable of the values of the average index of the annual rings from a 
selected location. 
The choice of one of two types of regression analysis is done by selecting the menu function 
Regression. Multivariate linear regression analysis is selected by 
Regression-> Linear Regression, and non-linear regression analysis using 
Regression-Nonlinear Regression as shown in Figure 15 
 

 

Figure 15Regression analysis type choice. 

 

After selecting the type of the regression analysis is tree species is selected (Fig. 8). 
Figure. 16 shows a window for selecting the location and the independent variables. The 
independent variables can be one or more of the following - the temperature for the years for which 
there is a calculated index difference of the mean temperatures , precipitation and a differential of 
average precipitations . 
Figure 17 shows the window for selecting the location, type of nonlinear regression and independent 
variables. The independent variables can be one or more of the following - the temperature for years 
for which there is a calculated index, difference of the mean temperatures , and precipitation and a 
differential of average precipitations. In case more than one independent variable is selected a 
regression analysis for each of them is carried out . 
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Figure 16 Dialog for choosing locations and independent variables for linear multidimensional regression analysis. 
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Figure 17 Dialog for choosing locations, independent variables and type for one dimensional regression analysis. 
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3. Web Application Description 

The web application is designed for public access to information related to the processing of the 
widths of the annual rings of all locations processed and stored in the database. 

3.1 Results 

Entering the link - http://sppam.e-ecology.org/results to the results page as shown on Figure 18. 
 

 

Figure 18 Results page of the wen application 

3.1 Registration and Login 

The system supports user registration, as logging-in is done by entering user name and a password as 
shown on Figure 19 and Figure 20. 

 

Figure 19 Web application login 

http://sppam.e-ecology.org/results
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Figure 20 Web application registration. 

 

3.2 Initial processing results display  
 

Access to the data from the initial processing is open to any visitor to the site . It operates through a 
consistent choice of tree species (Fig. 21) , country and location ( Fig. 22). After selecting a location a 
list of all rows of the location having R2> 0.45 is displayed. For each row the best approximation 
polygon and R2 are shown. 
When selecting the id of a location two graphics are visualized : 
1. The measured and approximated values of annual ring widths of the selected row. 
2 . The calculated index as the ratio between the measured and calculated values for each year. 
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Figure 21 Tree species choice. 
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Figure 22Country and location choice 
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Figure 23Graphics per selected sequence id. 


